Note: This short “manual” was originally written to be an online help system. Hence it is not intended to be a comprehensive users guide to Living Lexicon for Access. It is rather a collection of notes on various features of the application.
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LIVING LEXICON AT A GLANCE

Living Lexicon is a Microsoft Access application that you can use to work with local language vocabularies. With Living Lexicon you can:



edit vocabulary

print or output customized lexicons (i.e. dictionaries)

make, take and print language quizzes



HOW LIVING LEXICON CAME TO BE

When in 1993 the Peace Corps staff in The Gambia were preparing to rewrite the local language lexicons, they decided to use a database format instead of a conventional word processor. Living Lexicon was developed as a result.



The primary reasons for using a database format to record the language lexicons were to:



reduce the amount of data entry work by letting the computer generate the English-vernacular list.

assign words to categories, allowing Peace Corps volunteers/language instructors to create customized vocabulary lists tailored to their individual needs.

keep the lexicon easily available and editable for updates.

provide a quiz feature to let volunteers test their linguistic knowledge



Living Lexicon was originally written in Foxbase Mac/+ 2.0. It was later converted to Access 2.0 with enhanced features.



The Living Lexicon application was written by Andy Lyons (PCV ‘91-’95). Input was also given by Dave Bargeron (PCV ‘92-’94). The contents of the lexicons were prepared by Ebrima Colley (Mandinka) and Sierra Dem (Wollof). Credit also goes to the data entry clerks and staff of Peace Corps office in The Gambia for their assistance.



EDITING VOCABULARY

To edit the vocabulary words click the 'Edit' button on the main menu. The vocabulary editing screen has the following features.



Note: throughout this guide, the word “vernacular” refers to one of the local languages (Mandinka or Wollof)



Vernacular word - this is the main word whose definition is being edited. This can be a single word or phrase.



Lexicon Entry - if this box is checked, the vernacular word or phrase will appear as an entry when generating the vernacular-English lexicon. For the majority of vernacular words you would want this box checked. But if the vernacular word is a phrase used to translate a single English phrase, you may not want it to appear as an entry in the vernacular-English lexicon (you would however want it to appear in the English-vernacular lexicon - see below).



Categories - each vernacular word can belong to one or more usage categories. Simply enter the category(s) the word belongs to in this box. When a vernacular word belongs to a category, it will appear in any report, output, or quiz that includes the category. Categories are optional.



Translations - enter the different English translation(s) of the vernacular word. Each English translation should also be given a part of speech. A vernacular word can translate to more than one English definition or part of speech. The English definition can be a single word (literal translation) or phrase. If the Lex Entry box is checked then the English translation will appear as an entry in the English-vernacular listings. However if the English translation is a descriptive phrase, you may not want it to appear as a listing in the English-vernacular lexicon.



Note when entering English translations you don’t have to enter prefixes words or articles such as “to” or ”to be” or “a”. These prefix words will be entered automatically when printing the lexicons if the part of speech warrants it.



Sample sentence - At the bottom of the editing screen you can enter a sample sentence for each part of speech the vernacular word can function as.



Look For - if you want to edit the definition of a particular word, you can enter the word in this box and press enter. If you don’t know the exact spelling of the word, you can click the ‘Search’ button to see a list of all defined vernacular words.



LOOKING UP WORDS

Looking up words is easy with Living Lexicon. After clicking the ‘Look Up’ button on the main menu, you can choose to look up the English or vernacular word.



After selecting the language of the word you want to look-up (i.e. either vernacular or English), simply type the word and press enter. Note the spelling of the word you type must match exactly in order for the word to be found.



To see a list of all words (in case you don’t know the spelling of the word you want to find), click the ‘See List’ button. Then click the word you want to look-up and select OK.



PRINTING AND OUTPUTTING

You can easily look up an English or vernacular word. Living Lexicon also gives you several options for printing or outputting your lexicon. 



You can customize your lexicon by selecting only the words you need according to category and part of speech. You can also limit your list alphabetically and choose to include definitions and/or sample sentences.



For a quick printing of a lexicon, you can print one of the ready-made reports. For a more professional looking lexicon, you should output it as an RTF file and then modify the RTF file using a word processor such as MS Word 6.0.



PRINTING

You can print a quiz by clicking the Output button on the main menu. The following options are available when printing a lexicon:



include - tick the items you want to include in your lexicon. Note sample sentences can not be printed in English-Vernacular lexicons.



parts of speech and categories - tick the ones you want included in the lexicon

NOTE: there are some words which are not assigned to any word category. In order for these words to be included in your lexicon, all categories must be ticked.



from/to - enter the letters of the alphabet if you want to limit your lexicon alphabetically



first page number - enter the page number you want printed on the first page



After you have made your selections, click the Print or Print Preview button. 



OUTPUTTING RTF FILES

You can export a list of words to an RTF file. RTF stands for Rich Text Format, and is a file format that can be imported into virtually any Windows word processor.



To export a lexicon to an RTF file select Output from the main menu. After you select the options for your RTF file click the RTF button to create the file. 



USING AN RTF FILE

After you have saved a lexicon as an RTF file, you can then open the RTF file in a word processor or desktop publishing program and alter it it to make very professional looking lexicons in a dictionary format. Publishing a lexicon from a word processor also will significantly reduce the number of pages when compared to printing directly from Living Lexicon.



Here are some suggestions for using RTF files in specific programs:



Word for Windows 6.0

When you open an RTF file in Word it will appear as a table. The table will have the following columns: Word, Definition, Sample Sentence, Sentence Translation (your table may have fewer columns depending on the options you chose). To rework the table so that it appears more like a dictionary, follow the following steps.

Select the first column of the table (the words). Change the font to Mandinka Sans or Arial Bold.

Select the definition and sentence columns. Change the font to Mandinka Serif.

Select the sentence definition column and apply italics formatting. Note if your lexicon is large, you may have to break the table up into two or more smaller tables if your computer does not have enough RAM.

Select the table and select from the Tools menu Table To Text... Choose tabs as the delimiter.

After Word is finished, your lexicon will no longer be in a table format. Select all the text and then choose from the Format menu Tabs. Click the Clear All button and choose OK. This will clear the tab setting in the ruler.

Next choose Replace from the Edit menu. With the cursor in the Find box, select from the Special button Tab Character. You should see something like ^t in the find box. In the replace box type one space. The click find next and then replace. Word replaces the tab with a space. Then click Replace All.

After Word has replaced all the tab characters with spaces, select all the text and apply a 0.3 cm hanging indent either using the ruler or Format Paragrah.

Make some nice looking headers and footer (add borders for a professional touch) and set your margins.

Choose Format Columns and select 3 columns.



TIP: On the first Living Lexicon installation disk is a Word 6.0 template that contains macros and a toolbar that can be used to automate the conversion of an RTF file.



PAGE MAKER 5.0

You can go one step further by taking your lexicon file into Page Maker 5.0 to create a running header (i.e. the first word of each page will appear in the header). First open the RTF file in Word and apply the character formatting as described above. Convert the table to text and then replace all the tabs with spaces. Save the file in Word for Windows 2.0 format (Page Maker 5.0 can’t import Word 6 files directly). In Page Maker start a new document then Place the Word 2 file. Apply and paragraph formatting, indents, columns etc. To create a running header, select Running Header under Aldus Additions. Base the header on the first word of paragraph style “Normal” of each page. Play around with it until you get the placement you want.



QUIZES

Living Lexicon allows you to make, take, and print language quizzes. You can make and save up to 255 quizzes. The quizzes are randomly generated and are intended for fun only. They should not be interpreted as a measure of one’s ability in a language.



To take a language quiz click the Quiz button on the main menu. The quizzes screen shows all the saved quizzes for the current language.



To take a quiz, select a quiz and then click the Take Quiz button (or double-click the name of the quiz).



To find out information about a particular quiz, select the quiz and click the About button.



To make a new quiz, click the New button.



To delete a quiz and all its questions, select the quiz and click the Delete button.



To print a quiz, select the quiz and click the Print button.



TAKING QUIZES

To take a quiz on the computer, click the Quiz button on the main menu, then select the name of the quiz and click the Take Quiz button.



There are two basic types of questions.



For multiple choice questions, click or press the letter of the best answer. You have three chances to get the correct answer. If the answer is incorrect it will be grayed out. 



For fill-in the blank questions, type your answer and press Enter. To get fill in the blank questions correct, your spelling must be correct.



After a question has been answered, click on the Next Question button to advance to the next question.



Tips: You can click on any grayed out answer to see a definition of that word.

After the question has been answered, you can click on the Sentence button to see a sample sentence.



QUIZ SCORING

The questions in Living Lexicon quizzes are randomly generated. Hence for some questions there could be two or more possible answers or the question may not always make sense. Hence it should be remembered that the quizzes are for enjoyment only and should not be interpreted as a accurate measure of one’s ability in the language.



Each question is worth 3 points. For multiple choice questions, if you guess the correct answer on the first try, you get all 3 points. If you guess the correct answer on the third try you get 2 points, and on the third try you get 1 point.



For fill-in questions you only get one chance to enter the correct answer. If you get it correct you get 3 points.



If you click the Don't Know button, you don't get any points.



If your score ranks in the top five scores, you will prompted to enter your name into the Hall Of Fame. The top five scores can be seen by clicking the About button.



MAKING QUIZZES

You can make quizzes tailored to your own interests. To make a new quiz, click the New button on the Quizzes screen.



At the Make Quiz screen, you can determine the categories and parts of speech of the main question words. You do this by ticking or unticking individual Parts of Speech and Categories. (Hint: you can tick or untick all categories or part of speech by click the Auto Tick buttons with the left (to add) or right (to remove) mouse button.)



You can determine the number of questions of each type in the Number of Questions section. The maximum number of questions a quiz may contain is 500.



Finally you should give you quiz a name (maximum of 40 characters).



Click the Make Quiz button to make the quiz.



PRINTING QUIZZES

You can print a quiz made by Living Lexicon by selecting the quiz on the Quizzes screen and hitting the Print button. The printing options are:



Answer Column - check this box if you want an answer column to appear on the right hand side of the paper. For multiple choice questions, 5 bubble circles will appear where the user can shade in the correct answer. For fill-in questions, a line will appear where the user can write in the correct answer.



Answer Key - check this box if you want an answer key to be printed on the last page.



Group questions by type - select this radio button if you want the questions groups by type.



Randomize questions - select this radio button if you want the questions sorted in a random order.



Page Header - in this box enter the text that you want to appear at the top of each page of the quiz.



TIP: To export a quiz into a word processing program, print-preview the quiz and then choose Output... from the file menu and choose RTF format. You can then open the RTF file in a word processor such as Microsoft Word 6.0.



ABOUT QUIZES 

You can get information about a quiz by clicking the About button on the Quizzes screen or Take Quiz screen.



The About Quizzes screen displays the five high schools as well as the total number of questions in the quiz by type.



TIP: By clicking the About button on the quizes screen, you can change the name of the quiz. However this can not be done using the About button on the Take Quiz screen.



OPTIONS MENU

LANGUAGES

You can use Living Lexicon to keep a database of several different languages. Before you can enter words in a language, you must first define the language.



To define a language select ‘Languages...’ from the options menu on the main menu screen. Each language must have a unique ID number between 1 and 255.



Note if you delete a language on the Languages screen you should also use Delete Orphans to get rid of unused English words. You should also compact the database to recover disk space whenever a large number of records are deleted. 



CATEGORIES

You can define word categories and assign vernacular words to them so that you can limit the content of a lexicon or quiz to only those words belonging to a particular category(s).



To define new categories, select ‘Categories’ from the Options menu at the main menu screen. Each category must have a unique ID number between 1 and 255.



To assign vernacular words to one or more categories, open the Edit Vocabulary screen.



PARTS OF SPEECH

Parts of speech are not assigned to individual vernacular words or English words. Instead parts of speech are assigned to each Vernacular-English word combination. This is a more efficient data structure because each English word or vernacular word can have more than one part of speech.



Before a part of speech can be assigned to a vernacular-English combination, it must first be defined. Parts of speech can be defined by selecting “Parts of Speech...” from the Options menu on the main menu.



PREFIXES (Parts of Speech)

Each part of speech can be given a prefix. The prefix is the word(s) that normally precede the word when listed in a lexicon. While most parts of speech do not have a prefix, some common examples of prefixes are:



Part of Speech�Prefix�Example��verb�to�to walk��verb adjective�to be�to be hot, to be hungry��

When a prefix is entered for a part of speech, that prefix will be listed in the lexicons. Examples:



Vernacular-English lexicon

	vernacular word - [prefix] English translations

	Ex: kandita - to be hot, warm



English-vernacular lexicon

	[prefix] English word - vernacular translations

	to be hot - kandita



Because prefixes are added when printing lexicons, it is not necessary to include them when entering words. For example, you would not need to enter “to be hot”, but simply “hot”. The “to be” will be added by the computer automatically when needed. The correct entering of words will also ensure that the English-vernacular lexicon is alphabetized correctly (i.e. “to be hot” will be alphabetized under “H” instead of “T”)



SORTING ORDER

When you print a lexicon you want the word to appear alphabetically. However the special characters used in Mandinka and Wollof can cause some problems. Fortunately Living Lexicon has a trick you can use to specify the order you want.



When Living Lexicon prints a report or exports an RTF file, it doesn’t alphabetize in the normal way. First it converts each entry into special mapping string and then alphabetizes the list according to the converted string. To make the converted string, it replaces each letter of you word with a character you can specify.



Select Sorting Order... from the Options menu at the Main Menu to enter the Ascii codes for the sorting character mapping. You will probably need an Ascii table to help you do this as well as knowledge of how Access sorts strings. Both of these topics are available in Access on-line help.



SPECIAL CHARACTERS

The languages in Living Lexicon may have special characters not found in the English alphabet. This can make printing and viewing words difficult because a database field can only use one font (it’s not like a word processor that can mix fonts within the same word). However there are a few ways you can deal with this.



If there is a single font that has all the characters you need (including all the English ones) you can install that font. You will then have to alter many of the forms and reports in Living Lexicon, change the font properTy of all appropriate text boxes. You can then use the keyboard mapping feature to facilitate entering these characters.



If there is not a single font that has all the characters you need, pick the closest one. For characters that are not available, pick a close substitute and use that one for entering words/viewing on screen. However when it comes time to printing your lexicon, don’t use the built in reports but instead export the lexicon as an RTF file. Then open the RTF file in a word processor such as Word 6 and use the Find-Replace feature to substitute all the make-shift characters with a more appropriate character from a different font.



KEYBOARD

To help you input special characters, you can customize the keyboard. Select Keyboard... from the options menu at the Main Menu screen. You can program any combination of control-shift with any alpha-numberic character to send a special character you want. After you have programmed the keyboard, the key cominations will work in any form in Living Lexicon.



DELETING ORPHANED RECORDS

As a language database gets edited, there may be some English or vernacular words that get orphaned, meaning they’re not matched up with another word. These orphaned records are effectively useless because they won’t print on any report or be included in any quiz or look-up screen.



To delete orphaned vernacular and English words, select the ‘Delete Orphans’ from the Options menu on the main menu screen. If there are many orphaned records deleted, you can recover the disk space by compacting the database afterwards.



FILE LOCATIONS

In order to function properly, Living Lexicon needs to know the locations of the WAV files and this help file. These locations can be set by selecting ‘Files...’ from the options menu at the main menu screen.



For the path to the WAV files, you should enter the complete path including the drive letter but omitting the last front slash “\”.



FOR ADMINISTRATORS

INSTALLING LIVING LEXICON

The files on the setup disks are compressed; you must decompress them onto your hard drive before you’ll be able to run Living Lexicon. To install the program, insert Installation Disk 1. Then select File, Run... from Program Manager and type:



	 A:SETUP



Note to use the setup program, your computer must have Qbasic installed.



If you get an error message when you run the setup program, you may want to exit Windows and run the program from DOS. If this doesn’t work either, you can expand the program manually using the enclosed copy PKUNZJR or a similar utitily.



Living Lexicon also comes with two fonts and a Windows driver for the internal PC speaker (for computers without a sound card). These files are located on disk 1 and should be installed using the Windows Control Panel. See you Windows documentation for more information on installing fonts and drivers.



LIVING LEXICON FONTS

Living Lexicon makes use of two customized fonts called Mandinka Sans and Mandinka Serif. These fonts contain characters for the special ‘ng’ sound used in Wollof and Mandinka.



These fonts are used in Living Lexicon reports and forms. While these fonts are not essential to run Living Lexicon, you should install them for best output. 



SOUND

Living Lexicon has the capacity to play sounds. These sounds are played:



on start up

when answering quiz questions

when clicking the hidden “About Living Lexicon button”



In order to play sounds you must:

install the *.WAV files

have either a sound card or install the driver for the internal PC speaker



If your  computer does not have a sound card, you can install the driver for an internal PC speaker. This driver is contained on the setup disks.



To enable sounds select Sound from the Options menu at the Main Menu screen.



INTERNAL PC SPEAKER

Every computer has a little internal speaker. Although the quality of this speaker is usually poor, you can use this speaker to hear the sounds in Living Lexicon if your computer does not have a proper sound card.



Before you can hear sounds from your internal PC speaker in Windows, you must install a Windows sound driver. To install a Windows sound driver:



Insert Living Lexicon setup disk 1.

Start Windows.

Start the Control Panel.

Double-click the Drivers icon.

Click the Add button.

Select Unlisted or Updated Driver.

Select the drive letter for you floppy drive (A: or B:).

Select Sound Driver for PC Speaker.

In the driver setup box, change the setting in the Limit Playback to “12 seconds” (so you can hear the full score of the startup music).



See your Windows documentation for more information on installing drivers.



After you install the PC speaker, you can use it to hear sounds in Living Lexicon or any other Windows program. Double-click the Sound icon in control panel to set the sounds for different Windows events.



SOUND TROUBLE SHOOTING

If you can’t hear any of the sounds when answering quiz questions in Living Lexicon or you just hear beeps, double-check the following:



Make certain you have a sound card installed or the Internal PC Speaker

Make certain you have installed the *.WAV files

Make certain that sounds are turned on and you have entered the location of your *.WAV files in the Files dialog box (from Options menu).



LIVING LEXICON FILES

The following files are used in Living Lexicon:



File Name�Description�Essential�Network Location��LL_DATA.MDB�Raw data file�Yes�Shared directory��LEXICON.MDB�Application file�Yes�Workstation��LL_CNVRT.MDB�Conversion utility (to convert FoxBas Mac/+ DBF files to Access)�No�SysOp workstation��INTRO.WAV�Sound file�No�Workstation or server*��ABOUT.WAV�Sound file�No�Workstation or server*��NO[1-6].WAV�Sound file�No�Workstation or server*��YES[1-6].WAV�Sound file�No�Workstation or server*��LEXICON.HLP�This help file�No�Workstation or server*��

*for better performance put on workstation



DATA STRUCTURE 

Field�Type�Size�Notes��tblFWords - foreign words (primary key table) 	LL_DATA.MDB��FWordID�Counter��Primary Key��Fword�Text�30�Unique index with LanguageID��LangID�Number�Byte�Links to tblLang��LexEntry�Yes/No��Determines whether the record should appear as a lexicon entry��tblEngWords - English words (primary key table) 	LL_DATA.MDB��EWordID�Counter��Primary Key��Eword�Text�80�Can be a vocabulary word or additional description. (Unique index)��tblLang - languages (primary key table)	LL_DATA.MDB��LangID�Number�Byte�Primary Key��LangText�Text�20���Marked�Yes/No��Determines the active language, used as a criteria field for reports, quizes, etc.��tblMatches - matches between the tblFWords and tblEngWords	LL_DATA.MDB��FWordID�Number�Long�Part of composite primary key��EWordID�Number�Long���PosID�Number�Byte���LexEntry�Yes/No��Determines whether the match will be included when printing the English-vernacular lexicon.��tblPos - part of speech (primary key table)	LL_DATA.MDB��PosID�Number�Byte�Primary key��PosText�Text�20���PosAbbrev�Text�10�An abbreviation��Prefix�Text�10�Part of speech prefix��Marked�Yes/No��Criteria field for printing reports, outputting RTF files, making quizzes, etc.��tblSampSents - sample sentences	LL_DATA.MDB��FWordID�Number�Long�Part of composite key��PosID�Number�Byte���Sent�Text�255�The sample sentence (vernacular)��Trans�Text�255�The translation (English)��tblCats - categories (primary key table) 	LL_DATA.MDB��CatID�Number�Byte�Primary Key��CatText�Text�20���Marked�Yes/No��Criteria field for printing reports, outputting RTF files, making quizzes, etc.��tblFWordsCats - links FWords with their categories	LL_DATA.MDB��FWordID�Number�Long�Part of composite primary key��CatID�Number�Byte���tblKeys - keyboard shortcuts	LL_DATA.MDB��Shift�Yes/No��Status of shift key, part of composite primary key��Control�Yes/No��Status of control key, part of composite primary key��Character�Text�1�The keyboard character��Send�Text�1�The character sent��tblQTypes - question types (primary key table)	LL_DATA.MDB��QTypeID�Number�Byte�Primary key��QTypeText�Text�50�Name of question type��tblQuestions - question types (primary key table)	LL_DATA.MDB��QTypeID�Number�Byte�Primary key��QuizID�Number�Byte�Links to tblQuizes��QWordID�Number�Long�Links to tblFWords or tblEWords, depending on question type��PosID�Number �Byte�Links to tblPos��Choice[1-5]ID�Number�Long�For multiple choice questions, links to tblFWords or tblEWords, depending on the question type��AnswerID�Number�Long���AnswerNum�Number�Byte�For multiple choice questions, a number bewteen 1 and 5 indicating the correct answer.��SortNum�Number�Integer�A randomly generated number for presenting the questions in a random order.��PrimaryKey�Counter��Primary Key��tblQuizes - quizes (primary key table)	LL_DATA.MDB��QuizID�Number�Byte�Primary key��QuizName�Text�40�Name of the quiz��LangID�Number�Byte�Links to tblLang��tblQuizesScores - high scores for quizzes	LL_DATA.MDB��QuizID�Number�Byte�Links to tblQuizes��Score�Number�Integer�Score��Player�Text�30�Name of the player��PrimaryKey�Counter��Primary key��tblSortCodes - customized sorting order table	LL_DATA.MDB��CharCode�Number�Byte�Input character��MapCode�Number�Byte�Maps to character��tbl%OutTable - used for printing and outputing RTF files	LL_DATA.MDB��WordID�Number�Long�The word entry, links to tblFWords or tblEWords, depending on lexicon being printed��PosID�Number�Byte�Part of speech of the match��Word�Text�50�Main entry��WordTrans�Text�255�The translation��Sent�Text�255�The sample sentence (vernacular)��SentTrans�Text�255�The sample sentence translated (English)��PrimaryKey�Counter��Primary key��tblLocalOpts - links FWords with their categories	LEXICON.MDB��AddSound�Yes/No����WavePath�Text�50�Path to *.WAV files��
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